
Matematyczne aspekty analizy danych
semestr zimowy 2025/2026

Dr Anna Muranova
UWM w Olsztynie

Wykład 3

1 / 43



Wykresy

Kody:

from sympy import *
x = symbols(’x’)

f = 2*x+1
plot(f, line_color=’red’)

plot (x**2 +1)

Uwaga: możliwe, że trzeba zainstalować matplotlib i w ustawieniach na
komputerach w pracowni
File->Settings->Tools->Python Scientific->Show plots in tool
window 2 / 43



Wykresy 3d

Kod:

from sympy import *
from sympy.plotting import plot3d

x, y = symbols(’x y’)

f = 2*x + 3*y
plot3d(f)

Uwaga: możliwe, że trzeba zainstalować matplotlib i w ustawieniach na
komputerach w pracowni
File->Settings->Tools->Python Scientific->Show plots in tool
window 3 / 43



Podstawowe funkcje elementarne

Podstawowe funkcje elementarne obejmują funkcje:
▶ stałe f (x) = const,
▶ potęgowe f (x) = x r ,
▶ wykładnicze f (x) = ax ,
▶ logarytmiczne f (x) = loga x

▶ trygonometryczne f (x) = sin(x) i td,
▶ cyklometryczne (funkcje odwrotne do funkcji trygonometrycznych)

f (x) = arccos(x) td
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Rodzaje funkcje elementarnych

Funkcje, które można otrzymać z podstawowych funkcji elementarnych za
pomocą skończonej ilości działań arytmetycznych oraz operacji złożenia funkcji
nazywamy funkcjami elementarnymi.
▶ wielomianowa: f (x) = anx

n + an−1x
n−1 + an−2x

n−2 + · · ·+ a1x + a0
▶ liniowa f (x) = ax + b, a ̸= 0
▶ kwadratowa f (x) = ax2 + bx + c, a ̸= 0

▶ wymierna: f (x) =
anx

n + an−1x
n−1 + an−2x

n−2 + · · ·+ a1x + a0

bmxm + bm−1xm−1 + bm−2xm−2 + · · ·+ b1x + b0

▶ hiperboliczne, nprz: sinh x =
ex − e−x

2
, cosh x =

ex + e−x

2
https://pl.wikipedia.org/wiki/Funkcje_hiperboliczne

▶ polowe (odwrotne do hiperbolicznych), nprz. arcsinh = ln
(
x +

√
x2 + 1

)
https://pl.wikipedia.org/wiki/Funkcje_hiperboliczne_odwrotne

▶ funkcja Gaussa

fµ,σ(x) =
1

σ
√

2π
exp

(
−(x − µ)2

2σ2

)
.
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Funkcje nieelementarne

▶ funkcja znaku (signum)
▶ podłoga
▶ sufit,
▶ część ułamkowa (mantysa)
▶ funkcja Dirichleta

1Q(x) =

{
1 dla x ∈ Q,

0 dla x /∈ Q.

▶ Funkcja Γ (zwana też funkcją gamma Eulera) – funkcja specjalna, która
rozszerza pojęcie silni na zbiór liczb rzeczywistych i zespolonych. Jeżeli x
część rzeczywista liczby zespolonej z = x + iy jest dodatnia, to

Γ(z) =

+∞∫
0

tz−1 e−t dt, x > 0

6 / 43



Funkcja wykładnicza ex

Szczególnym przypadkiem funkcji wykładniczej jest ta o podstawie równej e –
podstawie logarytmu naturalnego. Innym oznaczeniem takiej funkcji jest exp(x)
nazywane krótko eksponensem.
Inna definicja eksponensa:

ex = exp(x) =
∞∑
k=0

xk

k!
.

import math

print(math.exp(1e-5) - 1) # gives result accurate to 11 places
print(math.expm1(1e-5) )

Oprócz tego math.exp(x) dokładniej niż math.e ** x oraz pow(math.e, x).
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Funkcja wykładnicza ex w sympy

Kody:

from sympy import *

x = symbols(’x’)
f = exp(x)

plot(f)
plot(f, (x, -2, 2))
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Granice

Granica funkcji – wartość, do której obrazy danej funkcji zbliżają się
nieograniczenie dla argumentów dostatecznie bliskich wybranemu punktowi.
Na przykład,

lim
x→∞

1
x
= 0

lim
x→∞

(
1 +

1
x

)x

= e

lim
x→∞

x sin

(
1
x

)
= 1

lim
x→0

x sin

(
1
x

)
= 0
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Granice w sympy

Kody:

from sympy import *

x = symbols(’x’)
f = x*sin(1/x)

plot(f, (x, -1, 1))
plot(f, (x, -20, 20))

print(Limit(f, x, 0).doit())
print(Limit(f, x, +oo).doit())
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Pochodne

Pochodne są bardzo ważne w analizie danych. Często używa się ich w uczeniu
maszynowym i innych algorytmach matematycznych, zawłaszcza w metodzie
gradientu prostego. Kiedy nachylenie jest równe 0, to oznacza, ze osiągnęliśmy
minimum lub maksimum zmiennej wyjściowej. Koncepcja ta jest przydatna w
regresje liniowej, regresje logistycznej i sieciach neuronowych.
Pochodna funkcji – nieformalnie: miara szybkości funkcji, czyli tempa zmian jej
wartości względem zmian jej argumentów.

lim
∆x→0

f (x0 +∆x)− f (x0)

∆x
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Obliczenie pochodnej, korzystając z definicji 1

Oblicz pochodną funkcji f (x) = x2 w punkcie x0 = 2, korzystając z definicji.

Rozwiązanie:
Liczymy wartość pochodnej w punkcie x0, korzystając z definicji:

f ′(2) = lim
h→0

f (2 + h)− f (2)
h

= lim
h→0

(2 + h)2 − 22

h

= lim
h→0

4 + 4h + h2 − 4
h

= lim
h→0

4h + h2

h
= lim

h→0
(4 + h) = 4
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Obliczenie pochodnej, korzystając z definicji 2
Możemy również policzyć z definicji wzór ogólny pochodnej dla tej funkcji
(f (x) = x2):

f ′(x) = lim
h→0

f (x + h)− f (x)

h
= lim

h→0

(x + h)2 − x2

h

= lim
h→0

x2 + 2xh + h2 − x2

h
= lim

h→0

2xh + h2

h
= lim

h→0
(2x + h) = 2x

Czyli ostatecznie:
f ′(x) = 2x

Można też napisać równoważnie:

(x2)′ = 2x

Korzystając z tak wyliczonego wzoru, możemy teraz obliczyć wartość
pochodnej w dowolnym punkcie, np.:

f ′(2) = 2 · 2 = 4, f ′(0) = 2 · 0 = 0, f ′(−5) = 2 · (−5) = −10

Praktycznie zawsze opłaca się najpierw policzyć pochodną funkcji (zwłaszcza,
że mamy do dyspozycji gotowe wzory na liczenie pochodnych), a dopiero
potem wyznaczyć jej wartość w konkretnym punkcie.
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Kalkulator pochodnych napisany w Pythonie

def pochodna_x(f, x, rozmiar_kroku):
m = (f(x + rozmiar_kroku) - f(x)) / rozmiar_kroku
return m

def moja_funkcja(x):
return x**2

nachylenie_w_punkcie_2 = pochodna_x (moja_funkcja, 2, 0.00001)
print(nachylenie_w_punkcie_2)

Wynik: 4.000010000027032
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Tabela pochodnych ważniejszych funkcji elementarnych
Nazwa funkcji Wzór funkcji i wzór jej pochodnej
funkcja stała (c)′ = 0
funkcja potęgowa, α ̸= 0 (xα)′ = αxα−1

pierwiastek kwadratowy, tzn. α = 1
2 (

√
x)′ = 1

2
√
x

funkcja wykładnicza, a > 0, a ̸= 1 (ax)′ = ax ln a
funkcja wykładnicza o podstawie e (ex)′ = ex

funkcja logarytmiczna, a > 0, a ̸= 1 (loga x)
′ = 1

x ln a

logarytm naturalny, tzn. a = e (ln x)′ = 1
x

sinus (sin x)′ = cos x
cosinus (cos x)′ = − sin x

tangens (tan x)′ = 1
cos2 x

= 1 + tan2 x

cotangens (cot x)′ = − 1
sin2 x

= −(1 + cot2 x)
arkus sinus (arcsin x)′ = 1√

1−x2

arkus cosinus (arccos x)′ = − 1√
1−x2

arkus tangens (arctan x)′ = 1
1+x2

arkus cotangens (arccot x)′ = − 1
1+x2

sinus hiperboliczny (sinh x)′ = cosh x
cosinus hiperboliczny (cosh x)′ = sinh x
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Ważniejsze reguły obliczenia pochodnych
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Przykład obliczenia pochodnych

f (x) = 3

√
1

1 + x2

Rozwiązanie:

f ′(x) =

(
3

√
1

1 + x2

)′

=

(
1

1 + x2

) 1
3
=

1
3

(
1

1 + x2

)−2
3
(

1
1 + x2

)′

=
1
3

(
1

1 + x2

)−2
3 (

(1 + x2)−1)′ = 1
3

(
1

1 + x2

)−2
3 (

−(1 + x2)−2) (1 + x2)′

=
1
3
(
1 + x2) 2

3
(
−(1 + x2)−22x

)
= −1

3
(
1 + x2)−4

3 2x

= − 2x
3
√

(1 + x2)4
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Przykład obliczenia pochodnych w sympy

from sympy import *

x = symbols(’x’)

f1 = x**2
print(diff(f1))
print(diff(f1).subs(x,3))

f2 = pow(1/(1+x**2), Rational(1,3))
print(diff(f2))
f2 = pow(1/(1+x**2), 1/3)
print(diff(f2))

2*x
6
-2*x*(1/(x**2 + 1))**(1/3)/(3*(x**2 + 1))
-0.666666666666667*x*(1/(x**2 + 1))**0.333333333333333/(x**2 + 1)
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Prosta styczna

y = f (x0) + f ′(x0)(x − x0), x ∈ R
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Prosta styczna, kod

y = f (x0) + f ′(x0)(x − x0), x ∈ R

from sympy import *

x = symbols(’x’)

f = x**2
der1 = diff(f)
x0 = 2

line = f.subs(x,x0) + der1.subs(x,x0)*(x-x0)
p1 = plot(f, show=False)
p2 = plot(line, show=False)

p1.extend(p2)
p1.show()
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Pochodne cząstkowe
(Funkcje wiele zmiennych)

Przykład:
f (x) = 2x3 + 3y2 + xz

▶ d

dx
– y , z jako stałe:

df

dx
= 6x2 + z

▶ d

dy
– x , z jako stałe:

df

dx
= 6y

▶ d

dz
– x , y jako stałe: :

df

dz
= x

▶ d2f

dx2 =
d

dx

(
df

dx

)
=

d

dx

(
6x2 + z

)
= 12x

▶ d2

dxdy
=

d

dx

(
df

dy

)
=

d

dx
(6y) = 0

▶ d2

dydx
=

d

dy

(
df

dx

)
=

d

dy

(
6x2 + x

)
= 0
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Pochodne cząstkowe w sympy

(Funkcje wiele zmiennych)

Przykład:
f (x) = 2x3 + 3y2 + xz

from sympy import *

x, y, z = symbols(’x,y,z’)

f = 2*x**3+3*y**2+x*z
#print(diff(f))#blad
print(diff(f, x))#6*x**2 + z
print(diff(f, y))#6*y
print(diff(f, z))#x
print(diff(diff(f,x), x))#12*z
print(diff(diff(f,x), y))#0
print(diff(diff(f,y), x))#0
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Całki (oznaczone)

Intuicyjnie całka oznaczona to pole powierzchni między wykresem funkcji f (x)
w pewnym przedziale [a, b] a osią odciętych, wzięte ze znakiem plus dla
dodatnich wartości funkcji i minus dla ujemnych. Pojęcie całki oznaczonej,
choć intuicyjnie proste, może być sformalizowane na wiele sposobów. Jeśli
jakaś funkcja jest całkowalna według dwóch różnych definicji całki oznaczonej,
wynik całkowania będzie taki sam.∫ b

a

f (x)dx .
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Całkowanie w sympy

from sympy import *

x = symbols(’x’)
f = x**2 + 1

F = integrate(f)#x**3/3 + x

print(F)
print(F.subs(x,1) - F.subs(x,0))#4/3

pole= integrate(f,(x,0,1))#4/3

print(pole)
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Obliczenie

∫ b

a

f (x)dx = F (x)
∣∣b
a
= F (b)− F (a), gdzie F ′(x) = f (x)

Przykład:∫ 1

0
(x2 + 1)dx = (

1
3
x3 + x)

∣∣1
0 = (

1
3
13 + 1)− (

1
3
03 + 0) =

4
3
≈ 1.3333333
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Całki – przybliżone obliczenia
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Całki – przybliżone obliczenia w Python

def przybliz_calke(a, b, n, f):
delta_x = (b-a)/n
suma = 0

for i in range(1, n + 1):
pkt_srodkowy = 0.5*(2*a + delta_x*(2*i-1))
suma += f(pkt_srodkowy)

return suma*delta_x

def moja_funkcja(x):
return x**2+1

pole = przybliz_calke(0, 1, n=1000, f=moja_funkcja)
print(pole)#1.333333250000001
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Prawdopodobieństwo

▶ w znaczeniu potocznym szansa na wystąpienie jakiegoś zdarzenia.

W rozumieniu potocznym wyraz „prawdopodobieństwo” odnosi się do
oczekiwania względem rezultatu zdarzenia, którego wynik nie jest znany
(niezależnie od tego, czy jest ono w jakimś sensie zdeterminowane, miało
miejsce w przeszłości, czy dopiero się wydarzy); w ogólności należy je
rozumieć jako pewną miarę przewidywalności bądź pewności względem
zjawiska (przy danej o nim wiedzy), co umożliwia ocenę potencjalnie
związanego z nim ryzyka.

▶ natomiast w matematycznej teorii prawdopodobieństwa rodzina miar
służących do opisu częstości lub pewności tego zdarzenia.

Prawdopodobieństwo w sensie matematycznym służy do modelowania
doświadczeń losowych poprzez przypisanie poszczególnym zdarzeniom
losowym liczb, zwykle z przedziału jednostkowego (często wyrażanych
procentowo: od 0 do 100%), wskazujących szanse ich zajścia.
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Prawdopodobieństwo a statystyka

▶ Prawdopodobieństwo – to czysto teoretyczne, niewymagające żadnych
danych rozważanie, jaka jest szansa na wystąpienia pewnego zdarzenia.

▶ Statystyka natomiast nie może istnieć bez danych, które wykorzystuje do
odkrywania prawdopodobieństw, oraz dostarcza narzędzi do opisu danych.
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Prawdopodobieństwo a statystyka: rzut kości

Mamy sześcian. Chcemy dowiedzieć się prawdopodobieństwo czwórki.
▶ Prawdopodobieństwo – zakładamy, jaki jest sześcian (nprz. uczciwy).

P(4) = 1/6.

▶ Statystyka: rzucamy sześcian dużo razy. Zakładamy, ze

P(4) =
Ilość czwórek
Ilość rzutów

.
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Prawdopodobieństwo a statystyka: rzut kości

Mamy sześcian. Chcemy dowiedzieć się:

P({liczba parzysta}) =?

▶ Prawdopodobieństwo – zakładamy, jaki jest sześcian (model
matematyczny):

P({liczba parzysta}) = P(2) + P(4) + P(6)

▶ Statystyka: rzucamy sześcian duży razy. Zakładamy, ze

P(1) =
Ilość jedynek
Ilość rzutów

i td. Wtedy używany naszego modelu:

P({liczba parzysta}) = P(2) + P(4) + P(6)
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Prawdopodobieństwo

Oto kilka pytań na które można odpowiedzieć poprzez podania
prawdopodobieństwa:
▶ Jaka jest szansa, że w 10 uczciwych rzutach wypadnie 7 orłów?
▶ Jakie mam szansa na wygranie wyborów?
▶ Czy mój lot będzie opóźniony?
▶ Na ile mam pewność, że pewien produkt jest wadliwy?
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Matematyczne interpretacje

Istnieje wiele matematycznych interpretacji pojęcia prawdopodobieństwa,
między innymi tzw. :
▶ obiektywne (częstościowe), jako obiektywną częstość zdarzenia w dużej

liczbie prób losowych,
▶ subiektywne (bayesowskie, od nazwiska T. Bayesa), jako reprezentację

subiektywnej pewności, uzyskanej na podstawie dotychczasowej wiedzy i
zaobserwowanych danych.
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Prawdopodobieństwo matematyczne: przykład

▶ Jaki jest prawdopodobieństwo, że w jednym rzucie uczciwym wypadnie
reszka:

X = {wypadnie reszka}

P(X ) = P({wypadnie reszka}) = 1/2 = 0.5(50%)

P({nie wypadnie reszka}) = 1/2 = 0.5(50%)

P({wypadnie reszka}) + P({nie wypadnie reszka}) = 1
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Prawdopodobieństwo matematyczne: przykład

▶ Jaki jest prawdopodobieństwo, że w trzech rzutach uczciwych wypadnie
dokładnie dwie reszki:

OOO
OOR
ORO
ORR
ROO
ROR
RRO
RRR

P({wypadnie dokładnie dwie reszki}) = 3/8

Uwaga!
P({wypadnie co najmniej dwie reszki}) = 4/8
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Szansa: przykład

▶ Szansa ze w rzucie uczciwym wypadnie reszka jest taka sam, jak ta, że
ona nie wypadnie:

O(X ) = O({wypadnie reszka}) = 1.

▶ Szansa ze w trzech rzutach uczciwych wypadnie dokładnie dwie reszki jest

O({wypadnie dokładnie 2 reszki}) = P({wypadnie dokładnie 2 reszki})
P({wypadnie inna ilość reszek niż 2})

=
P({wypadnie dokładnie 2 reszki})

1 − P({wypadnie dokładnie 2 reszki}) =
3/8

1 − 3/8
=

3
8 − 3

= 3/5
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Szansa

O(X ) =
P(X )

1 − P(X )

P(X ) =
O(X )

1 + O(X )

Szansa jest użyteczna w statystyce Bayes’a, a także w regresjach
logarytmicznych z logarytmem szansy.
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Prawdopodobieństwo łącznie 1

Dla zdarzeń A i B prawdopodobieństwo P(A oraz B) = P(A ∩ B) nazywa się
prawdopodobieństwom łącznym.

Jeżeli zdarzenia A i B są niezależne, to

P(A ∩ B) = P(A) · P(B).

Przykład: rzucamy uczciwy sześcian i uczciwą monetą:

P({czwórka oraz reszka}) = 1
6
· 12 =

1
12
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Prawdopodobieństwo łącznie 2

Dla zdarzeń A i B prawdopodobieństwo P(A ∩ B) nazywa się
prawdopodobieństwom łącznym.

Jeżeli zdarzenia A i B są niezależne, to

P(A ∩ B) = P(A) · P(B).

Przykład (zdarzenia zależne): rzucamy uczciwy sześcian:

A = {liczba parzysta},B = {2}

P(A) = 1/3,P(B) = 1/6

P(A ∩ B) = 1/6.
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Prawdopodobieństwo łącznie 3

Matematycznie zdarzenia A i B nazywają się niezależnymi, jeśli

P(A ∩ B) = P(A) · P(B).

Przykład: rzucamy uczciwy sześcian:

A = {liczba parzysta},B = {liczba, podzielna przez trzy}

P(A) = 1/2,P(B) = 1/3

P(A ∩ B) = P({liczba parzysta, podzielna przez 3}) = P(6) = 1/6.

Zdarzenia są niezależnymi!
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Prawdopodobieństwo alternatywne 1

Dla zdarzeń A i B, zdarzenie A lub B nazywa się sumą zdarzeń, a
P(A lub B) = P(A ∪ B) – prawdopodobieństwom sumy zdarzeń lub
prawdopodobieństwom alternatywnym.

Jeżeli zdarzenia są wzajemne wykluczającymi (P(A ∩ B)=0), to

P(A ∪ B) = P(A) + P(B).

Przykład: rzucamy uczciwy sześcian:

A = {2},B = {3}

P(A) = 1/6,P(B) = 1/6

P(2 ∩ 3) = 0.

P(2 ∪ 3) = 1/6 + 1/6 = 1/3.

Zdarzenia nie są niezależnymi!
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Prawdopodobieństwo alternatywne 2

Dla zdarzeń A i B, zdarzenie A lub B nazywa się sumą zdarzeń, a P(A ∪ B) –
prawdopodobieństwom sumy zdarzeń lub prawdopodobieństwom
alternatywnym.

P(A ∪ B) = P(A) + P(B)− P(A ∩ B).

Przykład: rzucamy uczciwy sześcian:

A = {liczba parzysta},B = {liczba, podzielna przez trzy}

P(A) = 1/2,P(B) = 1/3

P(A ∩ B) = P({liczba parzysta, podzielna przez 3}) = P(6) = 1/6.

P(A ∪ B) = P({2, 3, 4, 6}) = 1/2 + 1/3 − 1/6 = 4/6 = 2/3.
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Prawdopodobieństwo alternatywne 3

Przykład: rzucamy uczciwy sześcian i uczciwą monetą:

A = {liczba parzysta na sześcianie},B = {reszka i dwójka}

1O, 2O, 3O, 4O, 5O, 6O, 1R, 2R, 3R, 4R, 5R, 6R

P(A) = 1/2,P(B) = 1/12

P(A ∩ B) = 1/12.

P(A ∪ B) = 1/2.

Czy są niezależne?
Czy są wzajemnie wykluczającymi?
A jeżeli

B = {reszka i trojka}?

B = {reszka}
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